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Introduction
The Stigma is a software synthesizer plug-in for Microsoft Windows (VST2/VST3) and 
Apple macOS (VST2/VST3/AU) simulating the KORG® Sigma KP-30 Performing 
Synthesizer from 1979. It is written in native C++ code for high performance and low 
CPU consumption. The main features are:

● Nineteen Presets with individual filters, envelopes, and amplifiers
● Two band-limited oscillators with four footages (32', 16', 8', 4')
● Synthe preset section:

○ Eight presets including Noise
○ Individual lowpass and global highpass filters
○ Ring modulator

● Instrument preset section:
○ Eleven presets
○ Delayed Vibrato effect

● Effect section:
○ Portamento, Quarter Tone, Keyboard Sensor (aftertouch) and more

● Tweaks (not to be found in the original Sigma):
○ Up to 64 voices polyphony with Velocity
○ Preset editor
○ Chorus/Ensemble section

● MTS-ESP (https://oddsound.com/) dynamic micro-tuning support
● All parameters can be controlled by MIDI controllers
● Plug-in supports Windows (32 bit and 64 bit) and macOS (64 bit)

Changes in Version 1.2

The changes since version 1.1 do not seem to be very impressive:

● Resizable plug-in window
● Added “MIDI Thru” and “Ignore Program Change” options

However, under the hood Stigma was ported to the new iPlug2 framework maintained 
by Oli Larkin and the iPlug2 team. Big thanks, guys!!! Without your work it would 
not have been possible to create a resizable Stigma user interface.

To resize the plug-in you just grab the yellow triangle at the bottom right of the 
Stigma window and drag it. You can save the current window size using the menu 
entry  “Save Window Size” in the File Menu.

The Stigma Of The Sigma

Once upon a time I promised myself not to create a simulation of an existing piece of 
hardware that I do not own by myself. Well, as you can see, I broke my promise 
again: I never owned a Sigma nor is it very likely that I ever will. Hey, sounds like the 
introduction to my Nabla string synthesizer! ;-)

In 1979, KORG presented the Sigma KP-30 “Performing Synthesizer”. This 
monophonic instrument did not sell by far as good as its famous sibling, the MS-20, 
and the main reason was that it was a Preset Synthesizer. Now “preset” here meant 
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something slightly different than today's incarnation of this concept: You could not 
change a bit of the preset settings, it was all carved in stone… sorry, electronics... and 
there were only 19 (!) presets in total.

The engineers of KORG were well aware of this stigma, and so they added one 
tweakable parameter for each preset plus the option to additively select all 19 presets 
in every possible combination1 plus the option to Ring-modulate the 8 Synthe presets 
with the 11 Instrument presets.

Having presets is very important if you need to switch instantaneously between two 
sounds, and so the Sigma was the right instrument for many live musicians. But is it a 
real synthesizer or just a boosted organ? At least for the hardcore synthesists of the 
good old analog days the topic was settled… well, look, the Sigma has Rocker 
switches! :-P

The Truth About The Sigma

Let's forget all this snobbery and get back to the hard facts: The Sigma contains two 
voltage controlled oscillators (VCOs) that are able to generate sawtooth waves at four 
different octaves simultaneously (32', 16', 8', and 4'). The first VCO solely feeds the 
Instrument preset section while the second VCOs is used for the Synthe section.

A “preset” of the Sigma is in fact a full electronic circuitry that processes the output of 
a VCO at a certain footage. Take the preset “8' Saw” of the Synthe (sorry, it is really 
called like that) section: The input is taken from the 8' sawtooth wave of the second 
VCO (for some other presets the sawtooth wave is shaped into a pulse wave), filtered 
by a 2-pole lowpass filter (built around the famous K35 chip known from the PS series 
and early versions of the MS-10/20), and shaped by an envelope generator (both 
cutoff frequency and amplitude). This is the standard subtractive synthesizer 
architecture! And there are 19 of these (although not all identical nor all equipped 
with the K35)! Wow!

Architecture of one voice of the Stigma

1 Hence the adverted “524287 different tone color variations”: 219 = 524288. Minus 1 for the 
combination when no preset at all is activated. I <3 marketing.

8' Sawtooth 
from VCO 2

K35
LPF

VCA

Envelope

VCO 1

VCO 2

11 Instrument Presets

8 Synthe Presets

Ring 
Mod

M
ix

HP
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Typical Preset architecture (here the preset “8' Saw” in the Synthe section)

Now if you study the schematics of the Sigma you will see that the KORG engineers 
again did a great job in building clever circuitry with a minimum amount of hardware. 
In fact the characteristics of the presets are almost completely hard-wired, and 
altering the parameters of a preset sound would result in exchanging whole parts of 
the electronics (with a few exceptions). So is the statement that the Sigma contains 
19 synthesizers in one box true or false?

Definitely true is the fact that there are twelve K35 chips: Eight are built into the eight 
Synthe presets and the rest into four of the Instrument presets. Finally, a Ring 
modulator fed with the outputs of the Synthe and Instrument sections and followed by 
a highpass filter (indeed...) can be set to replace the original Synthe signal.

Apart from this unconventional architecture, the Sigma added some great perfor-
mance options: Two joysticks to control Pitch Bend/Vibrato and the Synthe section's 
lowpass/highpass filters plus Keyboard Sensor (today known as Aftertouch) used for 
pitch modulation, too. There are even more features to be found in the Effects section 
like Portamento, Delayed Vibrato, Multiple Trigger, and Quarter Tone. The latter is 
unique to the Sigma: When activated, playing notes legato will not result in chromatic 
but in quarter tone steps. Rumor says that because of this effect the Sigma got rather 
popular in the Mediterranean and especially the Greek region… 

From The Sigma To The Stigma

It took some time until I convinced myself to create a Sigma clone. Concept-wise the 
Sigma is fully in line with everything I love ‒ off-mainstream, unconventional 
architecture, clever design. But does it make sense to recreate a Preset synthesizer? 
Obviously maybe, and with the Stigma I went some new ways:

• First of all the Stigma is ‒ optionally ‒ polyphonic. For good reasons I did not 
add polyphony to the Mono/Fury but with the Stigma I think it has a real 
benefit.

• Second, Velocity is ‒ optionally ‒ available.

• Third, more sources are available for modulation purposes. For example you 
can now modulate the lowpass filters of the Synthe section by the Vibrato LFO 
(some users have successfully modified their original Sigma this way) or any 
MIDI CC.

• Fourth, an optional Chorus/Ensemble effect is on board.

• But most important I decided that one should have the possibility to edit the 19 
hard-wired presets themselves. Theoretically, this could be done with the Sigma 
by exchanging wires, resistors, and capacitors (nah, not really…) but with a 
plug-in this would be easy! Of course the extent of editing should be limited to 
what would be technically feasible with the original.

To sum it up: The Stigma simulates the Sigma but it can be tweaked to do more.



Stigma Manual Page 6
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The Instrument Section
The Instrument section contains 11 presets that can be individually activated by their 
associated Rocker switches. Each preset has one additional knob that controls one 
main parameter of the sound. The sources for all Instrument presets are the 
respective footages of VCO 1.

Do I have to mention that the sounds of the presets only remotely resemble the 
instruments denoted by the preset names? Remember that there a no samples etc. 
within the Sigma/Stigma...

Preset Base Waveform Parameter Control

32' Electric Bass 32' Sawtooth Cutoff frequency of K35 lowpass

32' Tuba 32' Sawtooth Cutoff frequency of K35 lowpass

16' Clavi 16' Pulse Pulse Width

16' Fuzz Guitar 16' PWM by Env Tone (Low / High mix)

16' Horn 16' Sawtooth Cutoff frequency of K35 lowpass

8' Trumpet 8' Sawtooth Cutoff frequency of K35 lowpass

8' Clarinet 8' Pulse Tone (Low / High mix)

8' Double Reed 8' Pulse Tone (Low / High mix)

8' String 8' Sawtooth Attack time

4' Flute 4' Sawtooth Tone (Low / High mix)

4' Hammered Percussion 4' Sawtooth Decay + Release time
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The Synthe Section
The Synthe section contains 8 presets that can be individually activated by their 
associated Rocker switches. Each preset has one additional knob that controls one 
main parameter of the sound. The sources for all Synthe presets are the respective 
footages of VCO 2.

There is also an additional Ring Modulator switch that replaces the standard output of 
the Synthe section with the Ring-modulated signal of the Synthe and the Instrument 
sections. Note that in order to hear any sound when Ring Mod is on, at least one 
preset of both sections has to be activated.

Along with the Ring Mod switch comes a control for (de-)tuning the VCO 2 by ± 7 
notes. This pitch control will only be active when Ring Mod is activated, too.

Preset Base Waveform Parameter Control

Ring Mod Synthe V Instrument Synthe (VCO 2) pitch

Noise Noise Attack + Release time

32' Saw 32' Sawtooth Attack + Release time

16' S/H 16' Sawtooth Sample & Hold clock rate

16' PWM 16' PWM by LFO Attack + Release time

8' Saw 8' Sawtooth Attack + Release time

8' Pulse 8' Pulse Decay + Release time

8' Rect 8' Rectangle Attack + Release time

4' Saw 4' Sawtooth Decay + Release time
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The Effects Section
The Effects section of the Stigma does not contain the kind of effects one would 
expect from a modern synthesizer (i.e. no Chorus, Flanger, Phaser, Delay, Reverb etc.) 
but some more basic features.

First there are the Octave Down and Octave Up switches that transpose the whole 
instrument by one octave up or down. If both switches are activated Octave Up wins. 
Above the two switches are controls for Master Tune and the individual tuning of 
VCO 2 (± 7 notes). Next comes the Portamento Rocker switch with the corresponding 
Time knob; the KBD Sensor activates the Aftertouch functionality while the Int. knob 
controls the intensity of the effect. For more on this see section KBD (Keyboard) 
Sensor.

Pitch bending and modulation by Vibrato or Noise (see section From Joystick To 
Wheels: Modulation Sources) can be activated separately for the Synthe (VCO 2) and 
Instrument (VCO 1) sections via the Pitch Joystick switches; the Range knobs control 
the amount of the modulation effect respectively. The Delay Vibrato only applies to 
the Instrument section. Knobs are available for Vibrato depth, speed, and delay time.

Quarter Tone is a very unique effect that typically only works in monophonic mode. If 
it is activated and one plays legato notes, the generated note steps are not chromatic 
but quarter tones. This becomes even more funny when you stop playing legato and 
then press the same key again (since it will now produce the “correct” note).

Multiple Trigger does what one expects it to do (trigger the envelopes even in legato 
mode) and the same is true for Key Hold (hold the pressed keys indefinitely).
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The Control Section
This section includes all the controls located left of the keyboard of the original Sigma: 
Volume and KBD Sensor settings as well as modulation sources (plus some more).

Volume, Balance, and Panorama

Volume sets the total volume of the Stigma while Balance controls the mix between 
the Synthe and Instrument section.

The original Sigma has no real stereo output but individual outputs for the Synthe and 
Instrument sections respectively. Instead I decided to provide two panorama controls 
for both sections as done with my Nabla synthesizer.

KBD (Keyboard) Sensor

Again a rather unique feature of the Sigma: Aftertouch! OK, the ARP Pro Soloist, the 
Teisco S-100P, and some others had it too, but it really was something unusual in 
1979.

While the intensity of the effect is controlled in the Effects section (see above), the 
destination can be set to Pitch Bend Up, Pitch Bend Down, or Vibrato. Furthermore, 
one can activate it for the Instrument or the Synthe section alone or together.

From Joystick To Wheels: Modulation Sources

The original Sigma features two (!) joysticks for modulation purposes: The horizontal 
axis of the first joystick directly controls Pitch Bending while the vertical axis controls 
the amount of modulation of the Vibrato LFO (when pushing the joystick “up”) or the 
Noise (when pulling the joystick “down”). In contrast, the horizontal axis of the 
second joystick is used to control the K35 lowpass filter cutoff frequencies of the eight 
presets in the Synthe section (and only those!) while the vertical axis sets the cutoff 
frequency of the highpass filter that follows the Synthe section.

However, joysticks are pretty out of fashion theses days (which is a pity) and to have 
two of them is pure luxury… thus, with the Stigma I had to go a different way to map 
the joysticks appropriately.
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There are four modulation paths available for the Stigma: Vibrato (Joystick 1 Y axis 
up; controls the Vibrato modulation depth), Noise (Joystick 1 Y axis down; controls 
the Noise modulation depth), LPF fc (Joystick 2 X axis; controls the cutoff of the 
Synthe lowpass filters), and finally HPF fc (Joystick 2 Y axis; controls the cutoff of the 
Synthe highpass filter).

For each modulation path the modulation source can be selected from one of the 120 
MIDI channel controllers, the output of the Vibrato LFO, the PWM LFO, the S/H LFO, 
Pitch Bend, or Channel Pressure (Aftertouch). Finally, Velocity is also available as a 
source for LPF fc.

Magic 

Yes, there is some magic built into the Stigma: Polyphony and Velocity. 
Here you can select the maximum number of voices (1 to 64) plus the 
amount of effect the Velocity has on the volume of the voice played.

The Sound Manager

But the greatest magic is of course this: A way of storing programs or patches and 
even giving them names! To select one of the 64 patches just click on the program 
number or the previous/next arrow buttons, and edit its name by clicking in the text 
field.

MIDI Learn

Every parameter of the Stigma can be controlled by one MIDI controller. If you want 
to change the assignment of MIDI controller (CC; MIDI Control Change) to Stigma 
parameter the MIDI Learn function comes in quite handy: Just click the MIDI Learn 
button on the Sound Manager panel (caption turns red) and wiggle both the MIDI 
controller and the parameter you want to assign (you can abort MIDI Learn by clicking 
the button again). If you want to unlearn the assignment, right-click the MIDI Learn 
button (the label now reads “UNLEARN”) and activate it. Now wiggle the MIDI 
controller or the parameter that you want to unlearn. To save the controller 
assignments use “Save Configuration” in the Options menu (see next section).
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File Menu

When clicking on the disk symbol of the File button, a context menu opens with the 
following options:

Copy Program Copy current program to internal clipboard

Paste Program Paste internal clipboard to current program

Init Program Initialize the current program

Load Program Load a program file containing a patch to the Stigma's 
current program

Save Program Save the Stigma's current program to a program file

Load Bank Load a bank file containing 64 patches into the Stigma

Save Bank Save the Stigma's 64 patches to a bank file

Select Startup Bank Select the bank file that should always be loaded when the 
Stigma is started

Load Startup Bank Load the Startup bank file; can also be used to check what 
the current Startup bank is

Unselect Startup 
Bank

Unselect the current Startup bank

Default Path for 
Program Files

Sets the default path for program and bank files

MIDI Thru Set globally if MIDI data sent to Stigma should be sent 
through to its MIDI output (stored in configuration file)

Ignore Program 
Change

Set globally if MIDI Program Change data sent to the 
Stigma should be ignored (stored in configuration file)

Reload Configuration Reload the Stigma's configuration file; see section The 
stigma.ini Configuration File

Save Configuration Save the Stigma's configuration file; see section The 
stigma.ini Configuration File

Load Preset Defaults Load the Stigma's Preset defaults from the configuration 
file; see section The stigma.ini Configuration File

Save Preset Defaults Save the Stigma's Preset defaults to the configuration file; 
see section The stigma.ini Configuration File

Save Window Size Stores the current window size to the configuration file so 
that it will be restored on the next loading of Stigma

Check Online for 
Update

When connected to the Internet, this function will check if 
a newer version of the Stigma is available at fullbucket.de

Visit fullbucket.de Open fullbucket.de in your standard browser
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Chorus/Ensemble

An impressive property of the Stigma is that it can easily 
produce some very thin sounds. To thicken these up there 
exists an optional Chorus/Ensemble section (not to be 
found on the Sigma). The Dry/wet balance between signal 
and effect can be set individually for both Synthe and 
Instrument as well as the speeds of the two modulation 
LFOs and the overall modulation depth.

By the way: If you don't like it you don't have to spill coffee over the Chorus. Just 
switch it off.
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The Preset Editor
Alright folks, grab your soldering iron and prepare to modify the very presets of your 
Sigma! It is possible, though cumbersome and error-prone, thus I would recommend 
to go the easy way and use ‒ ta-da! ‒ the Stigma Preset Editor. Just click on the dark 
plate below the Sound Manager and take a look what's inside.

What you see are the eight (in case of “16' PWM” nine) parameters that affect the 
character of a preset. To select the “right” editor for a preset you can either flip one of 
the switches above the Preset Editor, activate the preset via its Rocker switch, or push 
one of the red kick switches that appeared right under the Rocker switches once you 
“opened” the Preset Editor.

Here is what the Preset Editor can do for you:

• Every preset has the following parameters: Gain (preset volume), Attack, 
Decay, Sustain, and Release.

• All the Synthe presets plus the Instrument presets “32' Electric Bass”, 
“32' Tuba”, “16' Horn”, and “8' Trumpet” feature a K35 lowpass filter and thus 
the parameters Cutoff, Resonance, and Envelope Modulation.

• The preset “32' Tuba” is a bit different than the other “K35 presets”: Here the 
envelope signal is routed through a highpass filter before modulating the audio 
filter. This somehow removes the Sustain part of the envelope, resulting in a 
AD-like characteristic.

• The remaining Instrument presets contain a lowpass and a high/bandpass filter 
combination. The three parameters control the respective cutoff frequencies 
and the mix/balance between the two filters.

• The preset “16' PWM” has an additional knob to control the PWM LFO speed.

This might not look very spectacular because I restricted my Stigma to what the 
original Sigma would be capable. But remember that there are nineteen of these 
processing lines available ‒ in parallel!

Of course there is another aspect why I provide the Preset Editor along with the 
Stigma: I do not own a Sigma and even from the great video and audio material I 
studied it is sometimes pretty difficult to find the “right” setting for a preset. Now if 
you are a fortunate Sigma owner and have the feeling that a preset does not sound 
“right”, will you please edit it and maybe even provide it to the community? Great, 
thanks! You can do this by saving the preset defaults to the Stigma's configuration 
(stigma.ini) file; see below.
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The stigma.ini Configuration File
The Stigma is able to read some settings from a configuration file (stigma.ini); the 
exact location of this file depends on your operating system and will be displayed 
when you click on “Reload” or “Save Configuration”.

MIDI Control Change Messages

All parameters of the Stigma can be controlled by MIDI controllers, or more precise: 
Each MIDI controller (except Modulation Wheel and Sustain Pedal) can control one of 
Stigma's parameters. The mapping is defined in the stigma.ini for example like this:

[MIDI Control]
CC5   = 29 # Portamento Time
CC7   = 2  # Volume
CC8   = 4  # Balance
CC10  = 10 # Pan Instrument
...

The syntax is straight forward:

CC<controller number> = <parameter ID>

Given the above example, controller 7 directly controls the overall Volume parameter, 
controller 8 the Balance etc. As you can see, comments are introduced by the Pound 
sign (#); they are here just for description purposes and completely optional. 

The parameter ID of one of the Stigma's parameters is given in the section 
Parameters below. Note that the controller number can run from 0 to 119, with the 
exception of 1 (Modulation Wheel) and 64 (Sustain Pedal); the latter two are simply 
ignored. Of course, instead of editing the controller/parameter assignments in 
stigma.ini with a text editor it is much easier to use the MIDI Learn function and 
save the configuration (see section MIDI Learn above).

Preset Defaults

As already described in the section The Preset Editor the default settings for the 19 
presets can be saved and loaded from the configuration file. This provides an easy 
way of exchanging/restoring the default settings separately from the programs. Note 
that you still can have different preset settings per program!

[Preset Defaults]
NOISE P1 Gain=0.500
NOISE P1 Flt1=0.500
NOISE P1 Flt2=0.675
NOISE P1 E>F=0.265
NOISE P1 EnvA=0.500
NOISE P1 EnvD=0.000
NOISE P1 EnvS=1.000
NOISE P1 EnvR=0.505
32' SAW P2 Gain=0.500
...
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Parameters

Instrument Section

parameter ID description

32' ELECTRIC BASS
45 Preset On/Off

65 Filter cutoff frequency

32' TUBA
46 Preset On/Off

66 Filter cutoff frequency

16' CLAVI
47 Preset On/Off

67 Pulse Width

16' FUZZ GUITAR
48 Preset On/Off

68 Tone control

16' HORN
49 Preset On/Off

69 Filter cutoff frequency

8' TRUMPET
50 Preset On/Off

70 Filter cutoff frequency

8' CLARINET
51 Preset On/Off

71 Tone control

8' DOUBLE REED
52 Preset On/Off

72 Tone control

8' STRING
53 Preset On/Off

73 Attack time

4' FLUTE
54 Preset On/Off

74 Tone control

4' HAMMERED PERC
55 Preset On/Off

75 Decay + Release time
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Synthe Section

parameter ID description

RING MOD
36 Ring modulation On/Off

56 Pitch shift for VCO 2

NOISE
37 Preset On/Off

57 Attack + Release time

32' SAW
38 Preset On/Off

58 Attack + Release time

16' S/H
39 Preset On/Off

59 Sample & Hold clock speed

16' PWM
40 Preset On/Off

60 Attack + Release time

8' SAW
41 Preset On/Off

61 Attack + Release time

8' PULSE
42 Preset On/Off

62 Decay + Release time

8' RECTANGLE
43 Preset On/Off

63 Attack + Release time

4' SAW
44 Preset On/Off

64 Decay + Release time
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Effects Section

parameter ID description

OCTAVE DOWN 19 Transpose one octave down

Master Tune 7 Master tune

OCTAVE UP 20 Transpose one octave up

Synthe Tune 8 Tuning of VCO 2 (Synthe section)

PORTAMENTO
21 Portamento On/Off

29 Portamento time

KBD SENSOR
22 Keyboard Sensor (Aftertouch) On/Off

30 Keyboard Sensor (Aftertouch) intensity

PITCH JOYSTICK 
SYNTHE

23 Pitch modulation of VCO 2 On/Off

31 Pitch modulation range of VCO 2

PITCH JOYSTICK 
INSTRUMENT

24 Pitch modulation of VCO 1 On/Off

32 Pitch modulation range of VCO 1

DELAY VIBRATO 
INSTRUMENT

25 Delayed Vibrato for VCO 1 On/Off

33 Delayed Vibrato depth

34 Delayed Vibrato speed

35 Delayed Vibrato delay time

QUARTER TONE 26 Quarter Tone effect On/Off

MULTIPLE TRIGGER 27 Multiple Trigger On/Off

KEY HOLD 28 Key Hold On/Off

Chorus/Ensemble

parameter ID description

On/Off 76 Switch effect On/Off

Synthe Mix 77 Dry/Wet mix for Synthe section

Instrument Mix 78 Dry/Wet mix for Instrument section

LFO 1 Speed 79 Speed of first modulation LFO

LFO 2 Speed 80 Speed of second modulation LFO

LFO Depth 81 Depth of modulation by the LFOs
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Control Section

parameter ID description

Volume 2 Master volume

Balance 4 Balance/mix between Synthe and Instrument

KBD Sensor
5 Mode: Pitch Bend up/down or Vibrato

6 Destination: Synthe, Instrument, or both

Panorama
9 Synthe panorama

10 Instrument panorama

Vibrato Modulation
11 Modulation control source

12 Modulation control depth

Noise Modulation
13 Modulation control source

14 Modulation control depth

LPF fc Modulation
15 Modulation control source

16 Modulation control depth

HPF fc Modulation
17 Modulation control source

18 Modulation control depth

Voices 1 Number of voices (1 to 64)

Velocity 3 Velocity depth

Preset Editor

parameter ID description

PWM LFO Speed 82 Speed of PWM LFO

Gain X Preset volume

Filter Parameter 1 X+1 First filter parameter

Filter Parameter 2 X+2 Second filter parameter

Filter Parameter 3 X+3 Third filter parameter

Attack X+4 Attack time

Decay X+5 Decay time

Sustain X+6 Sustain level

Release X+7 Release time

Here X is the parameter offset for a preset: For the first preset (“Noise”) X is 83, for 
the second preset (“32' Saw”) X is 83 + 18 = 91, for the third preset (“16' S/H”) X is 
83 + 28 = 99 etc.
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Frequently Asked Questions

How do I install the Stigma (Windows VST2 32 bit version)?
Just copy the files stigma.dll from the ZIP archive you have downloaded to your 
system's or favorite DAW's VST2 plug-in folder. Your DAW should automatically 
register the Stigma VST2 plug-in the next time you start it.

How do I install the Stigma (Windows VST2 64 bit version)?
Just copy the file stigma64.dll from the ZIP archive you have downloaded to your 
system's or favorite DAW's VST2 plug-in folder. Your DAW should automatically 
register the Stigma VST2 plug-in the next time you start it.

Note: You may have to remove any existing (32 bit) stigma.dll from your VST2 
plug-in folder or else your DAW may screw the versions up...

How do I install the Stigma (Windows VST3 64 bit version)?
Just copy the files stigma.vst3 from the ZIP archive you have downloaded to your 
system's or favorite DAW's VST3 plug-in folder. Your DAW should automatically 
register the Stigma VST3 plug-in the next time you start it.

How do I install the Stigma (Mac VST2/VST3/AU 64 bit)?
Locate the downloaded PKG package file stigma_1_3_1_mac.pkg in Finder (!) and do 
a right- or control-click on it. In the context menu, click on “Open”. You will be asked 
if you really want to install the package because it comes from an “unidentified 
developer” (me ). Click “OK” and follow the installation instructions.

What is the plug-in ID of the Stigma?
The ID is k p 3 0 .

How can I decrease the Stigma's CPU load?
Whenever it does not degrade the sound you need, reduce the number of activated 
presets.

No Sound When I Activate The Ring Modulator?
Make sure that you have also activated at least one preset of both the Synthe and the 
Instrument section.

How do I know if a new version of the Stigma is available?
When connected to the Internet, open the File menu (see section File Menu) by 
clicking the disk icon and select the entry “Check Online for Updates”. If a new version 
of the Stigma is available on fullbucket.de the respective information will be shown in 
a message box.

How Can I Close The Preset Editor Plate?
You have to reassemble the plate; start with the loose hex nut. But put away that 
screw driver, please.
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How do I resize the MPS window?
Just grab the yellow triangle at the bottom right of the MPS window and drag it. You 
can save the current window size using the menu entry  “Save Window Size” in the 
File Menu.
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